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1 Introduction 

Implementation of the Digital Survey Plan (DSP) system revolutionizes submission, handling 
and storage of all cadastral survey plans and the update and maintenance of the provincial legal-
parcel base map. 

The Digital Survey Plan (DSP) project has two primary objectives. The first is replacing paper-
based legal plans with digital images and the second is providing a system through which the 
provincial legal-parcel base map is maintained and improved as close to source as possible. 

In the past, land surveyors submitted physical plans drawn up on mylar sheets. The Surveyor 
General launched the Digital Survey Plan (DSP) project to convert this process to electronic 
submission over the internet.  

All plans prepared pursuant to the: 

• Land Act 
• Coal Act 
• Mineral Tenure Act 
• Petroleum and Natural Gas Act 

  
are filed in the Crown Land Registry. Since the Surveyor General is responsible for the Crown 
Land Registry, all plans prepared pursuant to these statutes must be submitted to the Surveyor 
General Division of the Land Title and Survey Authority for review and confirmation. Under 
current practice, once a plan is confirmed it is filed into the Registry.  
 
To submit a plan through the Electronic File System (EFS), the land surveyor must save an 
electronic copy of the plan in PDF format (meeting an Adobe Acrobat standard). The land 
surveyor fills out an application form (available from the EFS) to deposit a plan into the Crown 
Land Registry. This application form also contains the equivalent of the Form 9 certificate. The 
land surveyor appends the PDF plan to the application form, digitally signs the application form 
certifying that the plan and survey are correct and have been checked with the Association of 
British Columbia Land Surveyors’ Electronic Checklist Registry. The digitally signed 
application form (with the PDF plan appended) is then submitted to the Surveyor General 
Division through the Electronic Filing System (EFS), which is part of the BC Online suite of 
applications.  

The plan and application form is delivered by EFS to the Surveyor General Division. Division 
staff review the plan and once the Surveyor General is satisfied he confirms the plan with his 
digital signature. Once confirmed, the plan is delivered to the Ministry of Agriculture and Lands’ 
ATLAS system for permanent retention. Plans filed in ATLAS are viewable through the 
ministry’s Tantalis and GATOR systems. 
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1.1 Accompanying offers 
Except for plans submitted under the Petroleum and Natural Gas Act and the Mineral Tenure 
Act, the plan must be accompanied by an offer from the Integrated Land Management Bureau of 
the Ministry of Agriculture and Lands (ILMB) – formerly Land & Water BC – which has been 
signed by the party receiving the tenure. Typically, this offer is submitted at the parcel 
designation stage; if not, it must be submitted at the same time as the plan. Plans submitted under 
the Mineral Tenure Act should have a prior parcel designation from the Surveyor General 
Division. 

==>Note: The offer must be sent under separate cover (by e-mail or conventional mail), not attached to 
an EFS submission. 
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 2 Getting started 

2.1 Step 1: Verify your computer environment 
The following is a checklist of what you will need in order to participate in the Crown Land 
Registry Digital Survey Plan system: 

• An internet-connected computer system  
• Adobe Acrobat Standard or Professional, version 6 or 7 (this User Guide assumes you are 

using Acrobat 6, Standard edition) 
• A software package capable of producing survey plans in electronic form 
• A suggested configuration of folders for EFS files. 

2.1.1 System requirements 

Category Windows Macintosh 

Hardware Intel Pentium processor, 
128MB RAM, 220MB free 
disk space, 800x600 
monitor, CD-ROM drive 

PowerPC® G3 processor, 
128MB RAM, 370MB free disk 
space, 800x600 monitor, 
CD-ROM drive 

System 
software 

Adobe 6.0 

Windows 98 SE, Windows 
NT 4.0, Windows 2000, or 
Windows XP  

Mac OS X  

System 
Software 

Adobe 7.0 

Windows 2000 or 

Windows XP 

Mac OS X v.10.2.8 or 10.3 

Web 
browser 

Microsoft Internet Explorer 5.01 

Internet 
connection 

Minimum: 56K dialup  
Recommended: High-speed cable or ADSL  

E-mail Required 

Note: Although Macintosh computers can access EFS, the instructions in this manual assume you are 
running Microsoft Windows. Some Mac users have experienced technical problems with Internet 
Explorer and reported better success with other browsers such as Netscape and Safari 

2.1.2 Adobe Acrobat 

In order to save the electronic forms used in EFS, you must have Standard or Professional, 
version 6 or 7 installed on your system. The EFS forms cannot be opened with earlier versions of 
Acrobat. Note that you must have the Standard or Professional version of Acrobat, not the free 
Acrobat Reader. 

To install Adobe Acrobat 6 or 7, follow the instructions supplied with the Acrobat CD. 
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2.1.3 Folders for DSP files 

Before you use DSP, we recommend setting up folders on your computer system for various 
types of DSP files. The following table suggests some sample folder names and locations. The 
actual folder structure you use will depend on the business needs of your firm. 
 

File type Sample folder name Comment 

Digital certificates 
(.APF or .PFX) 

LTOforms\certificates These files should be located on a local drive.For 
greater security, backup copies should be stored 
on removable hardware such as a USB Flash 
memory drive. 

CLRS Plan 
Submission Form 
template (.PDF) 

LTOforms\templates This file may be located on a local or shared drive.

In-progress and 
completed forms 
(.PDF) and EFS 
notifiers (e-mails) 

custom folders The folder structure for your in-progress and 
completed forms and related notifiers should 
reflect the work flow in your firm. You may want to 
separate completed but unsigned forms from 
signed forms. They may be located on a local or 
shared drive. 

Firm profiles C:\ LTOforms \profiles You must store firm profiles in this directory for the 
Import Profile button on the forms to work 
automatically. If you store them elsewhere, 
Acrobat will prompt you to select a profile when 
you click Import Profile. 

 

2.2 Step 2: Set up a BC Online account 

2.2.1 Applying for an account 

EFS is accessed through BC OnLine. Thus you or your firm must have a BC OnLine account and 
one or more user IDs. Each individual at your firm using BC Online must have their own user 
ID.  

To open a new BC OnLine account: 

1. Access the BC OnLine web page at http://www.bconline.gov.bc.ca and click the Account 
Setup tab.  

 
 
2. Click Opening a New Account and then New Account Page. The BC OnLine system will 

walk you through the process of downloading an application form (in Acrobat PDF).  

3. Print out and complete the form. Under Internet Services: Subscription Options, select 
Land Information Package. 
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4. To cover fees associated with EFS transactions and BC OnLine access, you will have to set 
up a BC OnLine Debit Account. You have three options for transferring funds to your 
account: 

– Automatic Electronic Funds Transfer (Automatic EFT). Automatic EFT requires you 
to specify an upper limit, lower limit (or “trigger point”) and maximum transfer amount 
for your account. Each evening, BC Online tops up your account to its upper limit (or 
moves over your maximum transfer amount – whichever is less). 

– PC Banking. Topping up your account through PC banking is exactly like paying a bill 
online through your bank. Payments may take up to 24 hours to reach your BC Online 
account. 

 The Automatic EFT option requires you to submit a specimen cheque (marked “VOID”) or a 
photocopied cheque along with your payment-authorization form. 

 For more information on all these options, see Account Setup on the BC Online web site. 

Note: For information on fees, see section 6.3 “Crown Lands, Land Titles and BC Online fees”. 

5. Mail or fax the form to BC OnLine, (including the specimen or photocopied cheque if 
necessary). 

Tip: The normal turnaround time for BC OnLine applications is 2–3 days; if you require rush service, 
contact the BC OnLine help desk. 

6. After processing your application, BC Online will send you an introductory package by 
Canada Post, including your user ID or IDs and default password. 

2.2.2 Notifier options 

BC Online applications often send you notifiers (for example, about the status of your 
submissions via EFS). Once you have set up your BC Online Account, you should set delivery 
options to determine where these notifiers will be sent. 

To set up delivery options for electronic notifiers:  

1. At the BC OnLine Main Menu, select Account Management → Service Delivery Options 
to access the Delivery Options screen.  

2. To specify where you want BC OnLine to send notifiers, select a Service Option (“User 
Mailbox”, “Account Mailbox”, or “Email”) for both Activity Advisory Services and 
Electronic Submission notifiers. If you select “Email” for either notifier type, enter an e-mail 
address under Email. 

3. Click Submit to update your notification settings or Reset to restore your original settings. 

==> Note: If you requested notification by e-mail, BC OnLine will send a confirming message to the 
address you specified. 

4. Click Return and then Main Menu to return to the BC OnLine Main Menu. 
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2.2.3 Folio tags 

Each transaction in EFS is labelled with a folio tag, which you enter in the upper left-hand corner 
of the associated screen. The folio tags exist for your convenience, to enable you to label 
transactions with a meaningful identifier, typically your firm’s file number. Folio tags can be any 
combination of up 15 characters.  

Folio tags appear on any EFS notifiers associated with a transaction, as well as on your BC 
Online statement. 

2.3 Step 3: Obtaining and installing digital signatures  
Before submission, all EFS forms must be digitally signed using a Digital Certificate registered 
with the Juricert (which is operated by the BC Law Society). 

British Columbia land surveyors, notaries public and lawyers can register digital signatures with 
Juricert. Only a British Columbia land surveyor can certify that a legal survey and plan are 
correct by applying their digital signature. 

Surveyors in your firm who will be digitally signing EFS Plan Submission forms need to apply 
to Juricert for a Digital Certificate. You should allow several days to complete this process.  

2.3.1 Obtaining a digital signature 

To apply for a digital certificate: 

1. Access the Internet site http://www.juricert.com, and click Registration. A web application 
will walk you through the process of applying for a digital signature. 

After validating your credentials (this may take several days), the certifying authority will 
send you an e-mail containing an ID and instructions for downloading your Digital 
Certificate. 

2. Inside the e-mail message, click the link to Acrobat Signing Certificate. Your Internet 
browser will open a page at www.juricert.com.  

3. Enter the ID you received in step 2 and the password you created when you applied for the 
certificate in step 1. 

4. Click Click here to start download. The system will prompt you for a file name.  

5. Save your Digital Certificate (file extension .APF or .PFX) in a suitable directory (e.g., 
“LTOforms\certificates”). 

2.3.2 Installing a digital signature 

To install a digital ID (Acrobat Version 6): 

A version of these instructions which will allow you to test your Digital Signature is available for 
download from the LTSA website at http://ltsa.ca/ltd_efs_forms.htm, near “Digital Signature Setup” (file 
name: setup_digital_cert_password V4.pdf). In case of any discrepancies in the following instructions, 
follow the current version of the “Digital Signature Setup” document. 
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1.  In Acrobat, select Edit → Preferences → Digital Signatures and set Signing Method to 
“Default Certificate Security”. 

 
 

2. In Acrobat, select Advanced → Manage my Digital IDs → My Digital ID Files and start 
with Select My Digital ID File. 

3. In the Select My Digital ID File dialogue box, click on Find your Digital ID File… 
Navigate to the folder where you stored the file you received from Juricert e.g. 
C:\MyLTOforms\certificates 

4. Double-click on the file name which will now appear in the Digital ID File in the window. 
Enter your Digital Certificate password and click OK. 

 
 A dialogue box may pop up and ask if you would like to convert the file to a supported file 

type, click Yes.  

 
5. A New Self-Sign Digital ID File dialogue box will open listing a converted Digital 

Certificate file with a .pfx extension. Click Save to save this file. 
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6. If another dialogue box Import Digital ID File asks if you want to import other files, click 

No. 

To install a digital ID (Acrobat version 7): 

These instructions will let you set up and test your digital signature using Adobe Acrobat version 7. 

1. Open the PDF file in Acrobat version 7. 

2. From the Acrobat menu bar, select Edit → Preferences → Security → Advanced 
Preferences → Creation. Ensure that the Default Method is set to “Adobe Default 
Security” 

  
3. From the Acrobat menu bar, select Advanced → Security Settings. 

4. In the Security Settings window, click Digital IDs and then click the Add ID icon. 

5. In the Add Digital ID window, select “Find an existing Digital ID” and click Next. 
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6. In the next dialogue box, click“Browse...., and navigate to the folder where you stored the 
file you received from Juricert (e.g. C:\MyCertificate\mynameX.apf). 

7. Double-click on the file name that now appears in the window. Enter your Juricert Digital 
Certificate password and click Next. Acrobat will display a window listing your new Digital 
ID 

 
8. click Finish. This will return you to the Security Settings window, which now includes your 

new Digital ID.  

9. Click once on this Digital ID to highlight it, then click the Set Default icon and click on the 
icon For Signing to establish this as the default Digital ID (certificate) you will be using to 
digitally sign forms. 

2.3.3 Digital ID passwords 

Juricert provides a password for each digital ID. This password cannot be changed. If your 
password is compromised, please inform Juricert immediately. They will revoke the digital ID 
and issue you a new one. 

2.4 Step 4: Download the forms 
The two forms used in this phase of electronic plan submissions, the Surveyor Registration form 
and the Survey Plan Submission form are available for download from the BC Online Electronic 
Filing web site. 
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2.5 Step 5: Registering as a surveyor  
A feature of DSP is the pre-assignment of plan numbers. (Please note that well site plan numbers 
are not pre-assigned, since the well site plan number is derived from the well site location.) In 
order to obtain plan numbers, a land surveyor with a Juricert-registered digital signature, must  
register with EFS,  a one-time registration process is accomplished by  submitting a Surveyor 
Registration form in the Electronic Filing system. Please note that once this form is registered, 
anyone accessing BC Online from the same account (in other words all user IDs assigned to the 
BC Online account) will be able to request plan numbers on behalf of the registrant. 

  

 

2.5.1 Complete the form 

The Surveyor Registration form is completed and digitally signed by a commissioned BC land 
surveyor. It authorizes LTSA to issue plan numbers to the surveyor and other users of his or her 
BC Online account. It is also used to cancel authorization. 

This form can only be submitted by a user of the BC Online account specified on the form. 

Enter your BC Online account number (not your BC Online user ID) and Commission Number. 
(The Commission Number must match the commission number submitted to Juricert on the 
digital signature application.)  

==>Note: A flaw in Acrobat requires you to click out of the commission number field prior to clicking 
into the signing box to apply your digital signature.  

Select a button to either request access to plan number pre-assignment, or rescind access for your 
account.  

2.5.2 Apply the digital signature 

1. To apply a digital signature to the form, click on the box next to the certification at the top of 
page 1. A Document is Not Certified dialogue box will pop up. 

2. Click Continue Signing. The Apply Signature - Digital ID Selection window will pop up; 
click on Show Options >> . 
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3. Double-click your Digital ID. The Apply Signature to Document window will appear. If a 

More Options button is visible, click it. 
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4. Under Signature Appearance, click “New”. 

5. Set Configure Graphic = “Name” and all other options off  

6. Set Configure Text = “Distinguished Name” and all other options off  

7. Click OK.In the Apply Signature to Document window click Hide Options << . 

2.5.3 Applying Your Digital Signature 

1. Enter your Digital Certificate password in the Apply Signature to Document window. (If 
you close and re-open Adobe Acrobat you will be asked to confirm your password twice.) 

2. Click on Sign and Save As to proceed with applying your digital signature. A file dialogue 
box will permit you to specify a new file name and another file folder location depending on 
your office standards. (A good naming convention is to just add the suffix “signed” to the file 
name – for example, CLRS_SMITH234.PDF might become 
CLRS_SMITH234_SIGNED.PDF ) 

 Your digital signature is applied to the file and a notation inserted into the digital signature 
box. This will generate a unique control number. 

==> Note: Once a digital signature is applied, the form cannot be modified in any way. Thus it is 
advisable to save an unsigned copy of the form before the digital signature is applied. Choose a 
descriptive name that denotes the file as being “unsigned” (e.g., unsigned_b47388_Form_CLRS_ 
Plan_Submission_SG_V4.pdf versus signed_b47388_Form_CLRS_Plan_Submission_SG_V4.pdf). 

2.6 Step 6: Submitting the Surveyor Registration form. 

1. In your browser, go to the BC Online site (https://www.bconline.gov.bc.ca/) and log in. At 
the Main Menu, select “Land Titles” and click Submit. 

 The system displays the Main Menu of Land Title System. 
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2. Click Submit Surveyor Registration to access the Submit Surveyor Registration screen. 

  
3. Optionally, enter a Folio number (your company’s internal reference number for the 

transaction).  

4. Click Browse… and select the completed and signed Surveyor Registration form from your 
PC. 

5. Click Submit. 
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3 Survey plan submission process 

3.1 Step 7: Obtaining plan numbers 

1. In your browser, go to the BC Online site (https://www.bconline.gov.bc.ca/) and log in. At 
the Main Menu, select “Land Titles” and click Submit. 

 The system displays the Main Menu of Land Title System. 

  
2. Click Request Plan Number and access the Request Plan Number screen. 

  
3. Complete the Commission # field and, optionally, the Folio field (your company’s internal 

reference number that will appear on the notifier). 
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4. To obtain one or more numbers select a number under # Plan Number Requested and click 
Request Plan #. 

– The preselected option Survey plans over untitled Crown Land (excluding SRWs) cannot 
be changed in this release of the system. 

==>Note: To obtain a listing of all your unused plan numbers, click Plan # Report. 

 In either case, the system will send a notifier to the BC Online mailbox or e-mail address you 
specified in section 2.2.2, “Notifier options”. To access the mailboxes, see section 3.6.3, 
“Viewing Your BC OnLine Mailboxes”. 

3.2 Step 8:Creating electronic plans 
All plans submitted to Surveyor General Division must be in Adobe’s Portable Document 
Format (PDF). PDFs can be created from most of the drafting software commonly used by BC 
land surveyors. Typically, this is done through a print-to-PDF option – that is, by “printing” the 
document (selecting File → Print), choosing “Adobe PDF” as your “printer”. Some software 
packages can create PDFs without using Adobe Acrobat software. Be aware that the Surveyor 
General Division can only provide technical support for documents generated by Adobe Acrobat 
software. PDFs produced by other software are submitted at the surveyor’s own risk. 

Certain software packages (e.g., Rapid Transit) cannot currently create PDFs. In such cases, 
users may print out plans and scan them into PDF format. 

3.2.1 Technical specifications for PDF plan images 

To be accepted by LTSA, PDF digital plan images must: 

•  meet PDF 1.5 specification or higher (i.e., equivalent to Adobe Acrobat 6). 

• not contain embedded WordPerfect fonts. 

Non-vector (e.g., scanned) plans should have a resolution of 600 dpi. 

3.3 Step 9: Complete the Survey Plan Submission form 
The Survey Plan Submission form must be digitally signed by a practising BC land surveyor. 

3.3.1 Complete the form 

==> Tip:When using Acrobat 7, selecting the “Highlight fields” and “Highlight required fields” from 
yellow information bar helps you to navigate through the form. 

ITEM 1 – BC Land Surveyor Identification 

Enter the name, address (including postal code) and phone number of the land surveyor who is 
completing the form. 

Enter the following data, pressing the TAB key to advance from field to field: 

(a) Name of the land surveyor 
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(b) Street address, line 1 

(c) Street address, line 2 (if necessary)  

(d) City 

(e) Province 

(f) Postal code 

(g) Additional instructions or information, typically a contact telephone and email, plus your 
own file reference number. 

Import Profile. Users who often enter the same information into this section may find it useful 
to create a profile of commonly used data. 

If a profile already exists, clicking on Import Profile will enter the default information stored in 
the profile. This information is editable. For information on creating profiles, see section 5.2, 
“Creating and using firm profiles”. 

ITEM 2 – Plan Identification 

Select the Act under which the plan is being submitted: 

• “Land Act” (default) 

• “Coal Act” 

• “Mineral TenureAct” 

• “Petroleum & Natural Gas Act” 

Depending on the plan you select, this item will display different sets of fields. 

“Land Act” selected 
• Enter the Plan Number and (if necessary, the Commission Number of the land surveyor who 

obtained the plan number (if different from the land surveyor completeing the survey)). 

 “Coal Act” selected 
• Enter the Plan Number and (if necessary, the Commission Number of the land surveyor who 

obtained the plan number (if different from the land surveyor completeing the survey)).  

 The form will display a Survey Type of “Coal Lease”.  

“Mineral Tenure Act” selected 
Enter the following fields: 

• Plan Number and (if necessary, the Commission Number of the land surveyor who obtained 
the plan number (if different from the land surveyor completeing the survey)). 

• Number of Units 

– The number of units determines the submission fee ($100 per unit; minimum fee $500) 

• Survey Type: 

– “Mineral Claim Survey” 
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– “Mining Lease Reduction Survey” 

– “Placer Lease Survey” 

“Petroleum & Natural Gas Act” selected 
Select a Grid (“Petroleum & Natural Gas” or “Peace River Block”) and complete the fields under 
Location (the exact fields displayed depend on the Grid you have selected): 

• “Petroleum & Natural Gas”grid selected: 
– Quarter Unit 

– Exception 

– P&NG Block 

– P&NG Group (three fields) 

– Land District 

• “Peace River Block” selected: 
– Exception 

– LS (Legal Subdivision) 

– Section 

– Township 

– Range 

– Meridian 

Note: The data in the grids is the basis for the Wellsite ID, which will appear on the form when 
viewed in the Submission Queue (see section 3.6.1 “Managing the submission queue”). 

ITEM 3 – Parcel Identification and Legal Description of Land 

If you selected Petroleum and Natural Gas Act under Item 2, Item 3 will be inapplicable. 

Enter the following data, pressing the TAB key to advance from field to field: 

• PIN (Parcel Identification Number) 

• Area 

• Legal Description 

To enter information on more than one parcel, click Use Schedule. Acrobat will append an extra 
page to the form (Additional Parcel Information), with space for information on up to eight 
parcels. Enter information on all the parcels on the schedule; don’t enter one parcel on the main 
form and the others on the schedule. 

To enter information on more than eight parcels, click Additional PIN Pages at the foot of the 
schedule. 
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ITEM 4 – Certification  

Enter the completion date of the field survey and survey plan, plus the ECR number and the date 
the ECR was completed.  

ITEM 5 – Alteration 

If the plan is being re-submitted with an amendment (see section 4.1, “Alterations and 
Resurveys”), select Alteration and enter the following information: 

• The previous submission’s control number 

• A description of the non-material alteration 

If the description requires more space than is available on the form, click Use Schedule. Acrobat 
will append an extra page to the form (Additional Description of Non-material Alteration). Enter 
the entire description here; don’t split the description between the main form and the schedule. 

If the description requires more than one page , click Additional Pages at the foot of the 
schedule page. 

ITEM 6 – Plan Data  

Show whether the plan is a resurvey by selecting the Yes or No checkbox. If it is a resurvey, 
enter the Previous Plan Number. 

Enter the names of Agencies driving the survey, with their Agency File Numbers. You can type 
in the agency name or select one of the values from the dropdown box (“Integrated Land 
Management Bureau (ILMB)” (formerly LWBC), “Parks”, or “Government ORCS”). 

To enter information on more than one agency, click Additional File Numbers. Acrobat will 
append an extra page to the form (Additional File Numbers Schedule), with space for 24 
additional agencies. 

Enter the following information: 

• Survey Method (“Field Survey” or “Compilation”) 

• Scale (e.g. enter “5000” for a 1:5000 plan scale) 

• Surveyor’s reference 

ITEM 7 – Explanatory Notes 

Enter any explanatory notes. This section replaces the cover letter that you may have submitted 
with a Mylar. If your explanation requires more than one page, click Additional Pages.  

3.4 Step 10: Append the plan image and electronically sign the form 
After the plan image is appended, the Survey Plan Submission form must be digitally signed by a 
registered BC land surveyor. 
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3.4.1 To append a PDF plan image to the form: 

1. From the pull-down menu in Acrobat Version 6, select Document → Pages → Insert and 
select the image file you want to insert. (In Acrobat Version 7, select Document → Insert 
Pages.) 

2. In the Insert Pages window, set Location to “After” and Page to “Last”. 

  
3. Click OK. Acrobat will append the survey plan image to the document. 

3.4.2 Apply the digital signature 

1. To apply a digital signature to the form, click on the box next to the certification at the top of 
page 1. A Document is Not Certified dialogue box will pop up. 

2. Click Continue Signing. The Apply Signature - Digital ID Selection window will pop up; 
click on Show Options >> . 
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3. Double-click your Digital ID. The Apply Signature to Document window will appear. If a 
More Options button is visible, click it. 

 
4. Under Signature Appearance, click “New”. 

5. Set Configure Graphic = “Name” and all other options off  

6. Set Configure Text = “Distinguished Name” and all other options off  

7. Click OK.In the Apply Signature to Document window click Hide Options << . 

3.4.3 Applying Your Digital Signature 

1. Enter your Digital Certificate password in the Apply Signature to Document window. (If 
you close and re-open Adobe Acrobat you will be asked to confirm your password twice.) 

2. Click on Sign and Save As to proceed with applying your digital signature. A file dialogue 
box will permit you to specify a new file name and another file folder location depending on 
your office standards. (A good naming convention is to just add the suffix “signed” to the file 
name – for example, CLRS_SMITH234.PDF might become 
CLRS_SMITH234_SIGNED.PDF ) 

 Your digital signature is applied to the file and a notation inserted into the digital signature 
box. This will generate a unique control number. 
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==> Note: Once a digital signature is applied, the form cannot be modified in any way. Thus it is 
advisable to save an unsigned copy of the form before the digital signature is applied. Choose a 
descriptive name that denotes the file as being “unsigned” (e.g., unsigned_b47388_Form_CLRS_ 
Plan_Submission_SG_V4.pdf versus signed_b47388_Form_CLRS_Plan_Submission_SG_V4.pdf). 

3.5 Step 11: Submitting the plan package 
All documents are submitted through the EFS Submit Document Package screen. A package is a 
set of forms submitted at the same time through the Submit Document Package screen. Several 
plan packages can be filed as part of the same package.  

To submit a document package to EFS: 

1. Click Submit Document Package at the EFS Main Menu (or on the navigation bar) to 
access the Submit Document Package screen. 

  
2. Enter your internal file number in the Folio Tag field (see section 2.2.3, “Folio tags”) 

3. Ignore the checkbox about registration notices. 

4. Select a Submission Type to determine when the package will be processed: 

• Immediate. The package will be submitted and processed as soon as you click Submit 
Package. 

• Hold. The package will be held in the submission queue, but not processed until you 
change the status to “Deferred”, “Immediate” or “Deleted” in the Submission Queue 
Management screen. 
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• Deferred. The package will be held in the submission queue, but not processed until 6:10 
AM on the date you specify. (It is possible to alter this date or to change the status to 
“Hold”, “Immediate” or “Deleted” at the Submission Queue Management screen.) 

==> Note: Regardless of the Submission Type you choose, EFS performs a basic validation on all 
packages as soon as you submit them. 

==> Tip: If you have completed a document but don’t want LTSA to examine it until later (e.g., 
when funds are available in a bank account), we recommend submitting the document on “Hold”, 
rather than submitting it later for immediate processing. By submitting it now, you can deal with any 
basic errors (e.g., missing electronic signatures) detected by EFS during initial validation. 

5. Click Browse… and select all the files you want to submit as part of one package. 

Several plans can be filed as part of the same package.  

If you need to select more than 10 files as part of the same package, click Add More Files. 
Wait a few seconds while EFS uploads the first 10 files. The screen will display space for 10 
additional entries at the bottom of the list.  

6. Click Submit Package. Wait a few seconds while EFS processes your submission. A 
message will appear telling you whether the submission was successful. 

==> Note: You must not initiate any other function until you have received the upload-complete message 
on this screen, or the upload will be discarded. 

7. If the submission fails, EFS will display an error message: 

Upload failed. Click here for error messages. 

Click the link to view and (optionally) print detailed error messages. Make the necessary 
changes to the rejected package and resubmit it to EFS. 

If the submission is accepted, you will receive a Notice of Receipt showing the Document 
Number, date and time of receipt, and financial information.  

3.6  Step 12: Manage the submission 

3.6.1  Managing the submission queue 

The Submission Queue Management function enables you to view submissions filed by you or 
your firm. These include submissions that have already been processed and submissions that are 
still in the queue, either on hold or with a deferred processing date. 

In the case of queued submissions, you can release them or change the deferred processing date. 

To view your submissions (or your firm’s submissions) to EFS: 

1. Click Submission Queue Management at the Land Titles Main Menu (or on the navigation 
bar) to access the Submission Queue screen.  
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2. By default, the screen displays submissions filed under your personal BC OnLine user ID 

that are currently queued (that is, awaiting processing). 

3. These settings can be changed as follows: 
– To display submissions processed during the last 90 days, change the value of the drop-

down list from “Queued” to “Processed” and click the Submit button. 

– To display submissions filed by all user IDs in your BC OnLine account, change the 
value of the drop-down list from “My Submission” to “Firm’s Submission” and click the 
Submit button. 

– You can sort the list of submissions by any of the column headings –Submission Status 
(default), Processed Date, Folio number, Submission Date, and Submitted By – by 
clicking on the column heading. 

To view the contents or change the status of a queued submission: 

1. On the Submission Queue screen, click the Submission Status of the package you want to 
view or change. The system will display the Package Detail screen. 
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This screen displays information about the submission, including a list of documents in the 
submission package. 

2. To view an image of a document, click the form name in the Document Type column. 

 
3. If the submission status is Hold or Deferred, you can change it by choosing a new value 

(“Immediate”, “Hold”, “Deferred”, or “Delete”) and pressing Submit. 

3.6.2 Following up your submission with Surveyor General Division 

Once a digital plan is received by the Surveyor General Division certain reviews are undertaken. 
Certain fundamental items on the plan will be confirmed by Surveyor General staff. Currently 
the status of plans being processed is recorded in a system within the Surveyor General Division 
which is not accessible to outside parties. 
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In order to ascertain the status of a particular plan please make contact with the Surveyor General 
Division by e-mail at sgdesig@ltsa.ca or by phone (250) 952-5021. 

3.6.3 Viewing Your BC OnLine Mailboxes 

To view electronic notifiers at either of your BC OnLine mailboxes:  

1. Click the BC OnLine Mailbox Services button, just above the navigation bar. A new screen 
opens, displaying the mailbox for your BC OnLine user ID. 

  

2. To view the contents of the mailbox for your BC OnLine account, click View Acct Mailbox.  

3. To view the contents of both mailboxes (for your user ID and for your Account), click Show 
All Items. 

4. To view a notifier, double-click on it. 

  
Click Return to return to your mailbox. 
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5. At your mailbox, click Return to return to the previous screen. 

==> Note: If you have configured BC OnLine to send notifications to an Internet e-mail account, you can 
access them like any other e-mail message. 
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4  Resubmitting defective submissions 

4.1 Alterations and Resurveys 
Submissions may be rejected for a minor defect that can be corrected, permitting the plan to be 
resubmitted as an Alteration. For example, a minor error in the expression of a bearing of a 
property boundary, a missing north arrow, or incorrect use of symbols will typically require an 
Alteration.  

When an existing parcel with a confirmed or approved Land Act survey plan is later surveyed 
with a different shape or grossly different dimensions, it is considered a Resurvey. Resurveys of 
P&NG Act well site plans are often required when platform or decking areas change, for 
example. 

4.2 Resubmitting a plan as an Alteration 
If a plan was rejected for an alteration, resubmitting it involves the following steps: 

• If the error was in the plan image itself, revise the electronic plan and create a new PDF image 
(see section 3.2 “Step 8:Creating electronic plans”). 

• Complete a new copy of the Survey Plan Submission form, using the same Plan Number and 
Commission Number as the rejected submission (see section 3.3 “Step 9: Complete the Survey 
Plan Submission form”). Be sure to fill out Item 5, Alteration. 

• Insert the new plan image in Adobe Acrobat and electronically sign the form (see section 3.4 
“Step 10: Append the plan image and electronically sign the form”) 

Re-submit the package in EFS (see section 3.4.2 Apply the digital signature 

1. To apply a digital signature to the form, click on the box next to the certification at the top of 
page 1. A Document is Not Certified dialogue box will pop up. 

2. Click Continue Signing. The Apply Signature - Digital ID Selection window will pop up; 
click on Show Options >> . 
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3. Double-click your Digital ID. The Apply Signature to Document window will appear. If a 

More Options button is visible, click it. 
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4. Under Signature Appearance, click “New”. 

5. Set Configure Graphic = “Name” and all other options off  

6. Set Configure Text = “Distinguished Name” and all other options off  

7. Click OK.In the Apply Signature to Document window click Hide Options << . 

3.4.3 Applying Your Digital Signature 

1. Enter your Digital Certificate password in the Apply Signature to Document window. (If 
you close and re-open Adobe Acrobat you will be asked to confirm your password twice.) 

2. Click on Sign and Save As to proceed with applying your digital signature. A file dialogue 
box will permit you to specify a new file name and another file folder location depending on 
your office standards. (A good naming convention is to just add the suffix “signed” to the file 
name – for example, CLRS_SMITH234.PDF might become 
CLRS_SMITH234_SIGNED.PDF ) 

 Your digital signature is applied to the file and a notation inserted into the digital signature 
box. This will generate a unique control number. 

==> Note: Once a digital signature is applied, the form cannot be modified in any way. Thus it is 
advisable to save an unsigned copy of the form before the digital signature is applied. Choose a 
descriptive name that denotes the file as being “unsigned” (e.g., unsigned_b47388_Form_CLRS_ 
Plan_Submission_SG_V4.pdf versus signed_b47388_Form_CLRS_Plan_Submission_SG_V4.pdf). 

• 3.5 “Step 11: Submitting the plan package”) 

• Monitor the submission to see if it is accepted. (see section 3.6 “Step 12: Manage the 
submission”) 

4.3 Resubmitting a plan as a Resurvey 
If a Resurvey is required, submitting it involves the following procedures: 

• If the Resurvey is of a Land Act plan, write, e-mail or fax a letter to the Surveyor General 
Division to formally request the plan’s withdrawal from the LTSA, unless you have already 
been instructed to conduct a resurvey.  

• Obtain a new plan number (once a plan is withdrawn the original plan number cannot be used 
again) 

• Revise the electronic plan and create a new PDF image (see section 3.2 “Step 8:Creating 
electronic plans”). 

• Complete a new copy of the Survey Plan Submission form, using a new Plan Number (see 
section 3.3 “Step 9: Complete the Survey Plan Submission form”). Leave Item 5, Alteration, 
blank. 

• Insert the new plan image in Adobe Acrobate and electronic sign the form (see section 3.4 
“Step 10: Append the plan image and electronically sign the form”) 
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Re-submit the package in EFS (see section 3.4.2 Apply the digital signature 

1. To apply a digital signature to the form, click on the box next to the certification at the top of 
page 1. A Document is Not Certified dialogue box will pop up. 

2. Click Continue Signing. The Apply Signature - Digital ID Selection window will pop up; 
click on Show Options >> . 

 
3. Double-click your Digital ID. The Apply Signature to Document window will appear. If a 

More Options button is visible, click it. 
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4. Under Signature Appearance, click “New”. 

5. Set Configure Graphic = “Name” and all other options off  

6. Set Configure Text = “Distinguished Name” and all other options off  

7. Click OK.In the Apply Signature to Document window click Hide Options << . 

3.4.3 Applying Your Digital Signature 

1. Enter your Digital Certificate password in the Apply Signature to Document window. (If 
you close and re-open Adobe Acrobat you will be asked to confirm your password twice.) 

2. Click on Sign and Save As to proceed with applying your digital signature. A file dialogue 
box will permit you to specify a new file name and another file folder location depending on 
your office standards. (A good naming convention is to just add the suffix “signed” to the file 
name – for example, CLRS_SMITH234.PDF might become 
CLRS_SMITH234_SIGNED.PDF ) 

 Your digital signature is applied to the file and a notation inserted into the digital signature 
box. This will generate a unique control number. 

==> Note: Once a digital signature is applied, the form cannot be modified in any way. Thus it is 
advisable to save an unsigned copy of the form before the digital signature is applied. Choose a 
descriptive name that denotes the file as being “unsigned” (e.g., unsigned_b47388_Form_CLRS_ 
Plan_Submission_SG_V4.pdf versus signed_b47388_Form_CLRS_Plan_Submission_SG_V4.pdf). 

• 3.5 “Step 11: Submitting the plan package”) 
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• Monitor the submission to see if it is accepted. (see section 3.6 “Step 12: Manage the 
submission”) 
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5  Additional information 

5.1 Managing digital signatures 
This section is added only as a convenience. Please consult the “Digital Signature Setup” 
document (file name: setup_digital_cert_password V4.pdf) at http://ltsa.ca/ltd_efs_forms.htm for 
the current version of these instructions. 

5.1.1 Setting default Acrobat digital ID file options 

In Acrobat, select Advanced… → Manage My Digital IDs →My Digital ID FILES and select 
My Digital ID File Settings 

 
 Double click on your Digital ID name (or click on Settings). For convenience you should set 

“Always use this Digital ID”. Once you have changed the settings, click on Close. 

 

==>Note: This is where you change your password and password settings. Your password is only 
changed in the .pfx file; the .apf file you received from Juricert retains its original password.  
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5.1.2 Setting appearance options for a digital signature 

LTSA (in consultation with the Law Society) has defined some preferred settings for digital 
signature formats to be used for EFS. You should select these settings the first time you apply a 
digital signature. For instructions on setting up your digital certificate and setting up your digital 
certificate appearance see 

http://ltsa.ca/documents/ltd/setup_digital_cert_password%20V4.pdf 

This document can be accessed from the LTSA website at http://ltsa.ca/ltd_efs_forms.htm (under 
Digital Signature). 

5.1.3 Security for digital signatures 

It is important to secure digital signatures against unauthorized use, through a combination of 
restricted physical access and electronic security measures. 

You can restrict physical access to PCs with installed passwords through conventional means 
such as locked doors or by storing the certificate on removable hardware such as a removable 
USB Flash memory drive. 

==> Note: To store a certificate externally, you must have Acrobat-level security activated. 

• Electronic precautions include Window-level security and Acrobat-level security. At the 
Windows level, all computer and network should be controlled through User IDs and 
passwords. Workstations should be set to lock up when left idle.  

• If you are comfortable with physical and Windows-level security measure you have in place, 
you may have no need for additional Acrobat-level security. However, if you have security 
concerns, you can set up Acrobat to prompt you for a password whenever you apply a digital 
signature. 

To set Acrobat-level security:  
1. In Acrobat, select Edit → Preferences → Digital Signatures to access the Preferences 

window for digital signatures.  
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2. Under Signing Method, select a level of security: 

– Default Certificate Security. With this option, Acrobat will prompt for a password 
whenever you apply a digital signature. 

– Windows Certificate Security. With this option, you can apply a signature without 
entering a password.  

5.2  Creating and using firm profiles  
Most EFS forms have a section requiring standard information such as the name and address of 
the firm completing the form. To simplify the entry of this repetitive data, these forms have an 
Import Profile feature that enables you to import frequently used data into the form.  

==> Note: You can edit this data after importing it. 

==> Tip: If you use the profile feature, we recommend making it your first action when you start filling 
out the blank form. If you import profile data to a partially completed form, you run the risk of 
overwriting fields you have already completed.  

5.2.1 Setting up profiles 

To create an firm profile: 

1. If you have not already done so, create a folder named “C:\LTOforms\Profiles”. 

2. Open a blank copy of the Survey Plan Submission form in Acrobat. 

3. Enter frequently used information into the first section (“BC Land Surveyor Identification”) 

==> Tip: In fact, you can enter any information you want to re-use into any section of the form. 
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4. From the pull-down menu bar, select Advanced → Forms → Export Forms Data, and save 
the file under the name “FIRMPROFILE.FDF”.  

==> Tip: If you want to use different firm profiles on different forms, use a different file name. 
Acrobat will prompt you to select a profile when you click the Import Profile button on a form. 

5.2.2 Importing profiles 

To use the Applicant or Institution Profile feature, click the yellow Import Profile button when 
you are filling out the appropriate section of a form. Acrobat will import the information you 
saved into corresponding fields of the current form.  
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6 Overview 

6.1 Roles 
The following actors play roles in the submission process of cadastral plans destined for the 
Crown Land Registry (CLR). (In practice the same individual may play several roles.) 

Actor Description/Role 

Land Surveyor 
(BCLS) 

Conducts a legal survey and prepares a survey plan.  

Application 
Coordinator  

Obtains approvals and consents, follows up with CLR on the status of submissions. Manages 
the submission process. 

Subscriber  A practising  British Columbia land surveyor, lawyer, or notary public, registered with 
Juricert, that digitally signs the application form and takes responsibility for the information 
contained therein 

Note: Only a BCLS can legally their digital signature to the plan submission form. 

Submitter A person who holds a BC Online ID; and who submits electronic plans and forms which have 
been digitally signed by a subscriber through EFS 

Examiner LTSA staff who examine, approve and file survey plans 
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6.1.1 Systems 

The following systems are involved in the submission process: 

System Description/Role Location 

Adobe Acrobat Used to (1) create PDFs of plans 
and complete electronic forms, (2) 
insert PDFs into completed forms, 
and (3) affix electronic signatures 
to form packages. 

User’s desktop 

3rd-party software Used to create electronic plans 
and (optionally) convert them to 
PDF. 

User’s desktop 

BC Online Gateway to Electronic Filing 
System 

Online 

Electronic Filing 
System (EFS) 

Used to (1) download forms, (2) 
obtain plan number s (3) submit 
forms and form packages, and (4) 
manage submission status. 

Online 

Surveyor General 
Division 

The gatekeeper for all plans that 
are to be filed in the Crown Land 
Regsitry 

 

Crown Lands 
Registry (CLR) 

The repository for all legal plans 
prepared pursuant to the Land Act, 
Mineral Tenure Act, Coal Act and 
Petroleum and Natural Gas Act.  

Back-end system 
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6.2 Submissions to the Crown Lands Registry 

6.2.1 Getting Started 

Before submitting survey plans to the Surveyor General Division, you must ensure that your 
environment is properly set up. The following is a checklist; see section 2 “Getting started” for 
details.  

Step Actor Action Description System/Program 

1 Land 
Surveyor 

Verify user’s environment Ensures the user’s hardware and software 
meets project requirements 

 

2  Obtain a BC Online account 
with EFS access 

Submits application to BC Online, obtains 
ID, sets notification options  

BC Online 

3  Obtain a digital signature Applies for a digital certificate from 
Juricert  

Juricert website 

4  Obtain forms Downloads electronic forms from BC 
Online Electronic Filing Website 

 

5  Complete the Surveyor 
Registration form (not required 
for well sites) 

Authorizes other IDs to request plan 
number assignments through your BC 
Online account. 

BC Online/EFS  

6 Submitter Submit the Surveyor 
Registration form  

Logs in and submits the form at BC Online 
Electronic Filing Website.  

BC Online/EFS 
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6.2.2 Submitting plans  

Step Actor Action Description System/Program 

7 Land 
Surveyor 

 

Request Plan numbers (not 
required for well sites) 

Logs in and requests pre-authorized plan 
numbers. 

BC Online/EFS 

8  Create survey plan PDF Convert the survey plan to a PDF 
document. 

Adobe Acrobat 
or 3rd-party 
software 

9  Complete the Survey Plan 
Submission form 

Complete the required information. Adobe Acrobat 

10  Attach survey plan PDF Attaches the PDF plan image to the Survey 
Plan Submission form. 

 

11  Digitally signed the Survey 
Plan Submission form 

Digitally sign the form certifying the plan 
being submitted is correct. 

 

12 Submitter Submit Document Package Logs in and submits a form package 
Receives notifications of submission status 

BC Online/EFS 

13  Follow up submission Checks for error message and notifiers; 
follows up on issues. 

 

(14) Land 
Surveyor 

Analyse failed submission If the submission fails, determine why   

6.2.3 Resubmitting a plan for a non-material defect 

Step Actor Action Description System/Program 

1 Submitter Revise 
form 

Revise the corrected Plan Certification or Plan Submission 
form, marked as “Alteration”, retaining the same Commission 
Number 

Adobe Acrobat 

2  Re-submit 
form 

Re-submit the plan (under the same plan number) following 
the procedure in “Submitting Plans” (above), beginning at 
step 8.  

BC Online/EFS 

6.2.4 Resubmitting a plan for a material defect 

Step Actor Action Description System/Program 

1 Submitter Request 
withdrawal of 
plan 

Write or fax a letter to the CLR formally requesting 
the plan’s withdrawal 

Manual process 

2 Examiner Withdraw plan Change status of submitted plan to Withdrawn and 
cancel survey. 

CLR 

3 Land 
Surveyor 

Re-submit plan Revise the plan and re-submit (under a new plan 
number) following the procedure in “Submitting 
Plans” (above). 

various 
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6.3 Crown Lands, Land Titles and BC Online fees 
The processing fees associated with digital survey plans are $2.50 per digital signature ( which 
flows to Juricert) and $1.50 (plus GST) for each submission via EFS.  

Statutory fees for the submission of plans to the Crown Land Registry are explained on the Land 
Title & Survey Authority website (http://www.ltsa.ca/ltsa_fees.htm#SGD_Fees). 
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7  Frequently asked questions 

7.1 Can I share my BC OnLine User ID with other staff in my office? 
No, you must have a unique BC OnLine User ID as all submission queue management and 
electronic notifier delivery functions are filtered based on your User ID. 

7.2 Will someone have to use my User ID to access my submissions and notifiers if I 
am away? 
No, there are provisions in the system for other staff members of the same firm to access 
information at a BC OnLine account level rather than the default User ID level. 

7.3 Can I log on with my User ID from two different computers at the same time? 
No, the system tracks multi-part submissions and multi-page queries based on your User ID and 
both you and the web site will become very confused if you use two computers simultaneously. 

7.4 Can I log on to BC OnLine using two browser sessions on the same computer? 
It is highly recommended that you do not do this. It will cause problems for you in EFS. 

7.5 How often should I save the form I am working on? 
You should always save the form after entering any significant amount of data. 

It is highly recommended that you save the form before printing in case you experience system 
difficulties while printing and have to re-start Acrobat. 

Save the form by selecting File → Save or File → Save As... from the menu bar. 

7.6 Why do I get the message indicating the form has been saved too many times? 
When you Save a form Acrobat does a “quick save” by appending the changes to the end of the 
file (just like Microsoft Word). Consequently, the file keeps getting larger. To reduce the file to a 
smaller size, do a Save As and give the new file a different name. 

7.7 Why does the cursor disappear when I press the ENTER key? 
The ENTER key only tabs to the next line in a multi-line text field. Most fields in the LTO forms 
are single line text fields and the ENTER key does not do what you think it should. 

Pressing the ENTER key in Acrobat “commits” the data entered in the current field and puts you 
into “document editing” mode in which ENTER pages forward in the document!  

If you type in a character after pressing ENTER that character acts as a keyboard command and 
starts to do a number of things you probably never intended. To return to “form” mode, click on 
the “hand” in the toolbar or click on a form field to re-position the data entry cursor. 
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7.8 How do I move the cursor to the next form field? 
Use the TAB key or mouse click on any field to move the cursor to that field. 

7.9 Why does it take so long to load Acrobat? 
Acrobat loads numerous “plug-ins” whenever it is started. You can avoid long startup times by 
leaving Acrobat active and using the File / Open / Close functions to switch between form files. 
Multiple open forms may be accessed by selecting the one you want to work with from the 
Window menu. Note that retaining too many open forms may slow your system down if you do 
not have adequate RAM memory on your PC. 

7.10 How do I clear the data in a field if I want to avoid editing errors and move on? 
Use the DELETE key to erase data in a forward direction and the BACKSPACE key to erase 
data in a backwards direction until the cursor is repositioned at the beginning of the field. You 
may then exit to the next field by pressing the TAB key. Note that entering a blank does not 
“clear” the field – Acrobat treats a blank just like any other valid character. 

7.11 Why did the cursor turn into a strange cross-hair symbol? 
You have inadvertently switched into “document editing” mode. To return to “form” mode, click 
on the “hand” in the toolbar then click on a form field to position the data entry cursor. 

7.12 I prefer having a printed manual rather than using online Help – can I get an 
Acrobat Guide? 
You can print the Acrobat Online Guide by selecting Help…Complete Acrobat Help and 
clicking on the Print icon. 

7.13 Can I select another type font for form fields? 
The type font is pre-set as Helvetica 12 point type and can not be changed. This type font has 
been selected to provide appropriate spacing in form fields and to provide good legibility for 
scanned and faxed forms. 

7.14 Sometimes, when I print a draft copy while still working on the document, a field 
on the printed version does not quite match what is on the screen. Why does this 
happen? 
If the cursor is still positioned in the field the data has not been “committed” i.e. you can still 
change your mind and Acrobat may print and/or restore the previous field value. 

If you Save the form, or TAB to the next field, or press ENTER, the data is committed and what 
appears on the screen and what is printed will be identical. The only exception is the semi-colon 
field separator characters in the name fields which are never printed. 

The recommended approach, after having created a new form or having made corrections to an 
existing form, is to press ENTER, Save or Save As the form, then click on the Print icon. 
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7.15 I imported data from an old form but the data in one field is incomplete and the 
cursor appears to be “locked up” so I can’t correct the data. Why does this 
happen? 
The form field on the new version of the form is shorter than the data you imported from the old 
form. The only way to “unlock” the cursor is to drag the cursor to highlight some of the data and 
then press Delete to erase it. You can then edit the remaining data in that field. 

7.16 I accidentally switched to the Bookmark mode – how do I get back to “form” 
mode? 
Just click on the Bookmark tab. 

7.17 I never use bookmarks – can I just get rid of the tabs? 
A simple way to do this is to place the mouse pointer on the window border between the tabs and 
the document window, click and hold the left mouse button, and just drag the window border to 
the edge of the screen. 

7.18 Why do I always get a Select File dialogue box displayed when I try to import a 
profile? 
This generally indicates the file name is incorrect, the file has not been placed in the correct 
folder i.e. C:\LTOformsProfiles (spelling?) or the person setting up your corporate profiles has 
placed all of the profiles on a shared dive e.g. X:\LTOprofiles. 

7.19 When I use the BC OnLine Submission Queue facility to review my Processed 
submissions and follow the link to retrieve the form (Acrobat PDF file) I 
submitted (which has now been imprinted with the application numbers and 
date/time of receipt). Why does the digital signature box have a red X in it? 
The red X is used by Acrobat to warn you that the document has been modified since the 
document’s digital signature was applied and verified. That is true – imprinting the application 
number(s) and date/time of receipt technically modified the document. 

However, a printed copy of the document will correctly show the digital signature without the 
red X. The EFS system validates documents at time of receipt and ensures that any document 
received has not been modified after the digital signature was applied. 

7.20 Why does Acrobat sometimes display a yellow question mark in the digital 
signature box? 
This indicates that Acrobat does not have direct access to a certificate registry and is thus unable 
to confirm the identity of the person whose digital signature is on the document. 

7.21 I am trying to submit a package but received a message “A technical error has 
occurred”. What did I do wrong? 
Generally this is not your fault. A technical problem has been detected at the BC OnLine Web 
Server while processing your request. These problems are generally transient in nature and will 
automatically and quickly be rectified. 
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You should click on the green Active Session tab at the top of the screen which will return you 
to the main menu. Select the Submission Queue Management function if you were submitting 
a package or a declaration and check if the function you were performing was successfully 
completed or not. If not, try again, e.g. re-submit the package. If you were submitting a PTT 
Account Authorization form, select PTT Account Management to check if the function you 
were performing was successfully completed or not. If not, try again, e.g. re-submit the PTT 
Electronic Payment Authorization form. 

If the situation persists, please contact the BC OnLine Help Desk. 

7.22 How can I ensure that I have sufficient funds in my deposit account to cover EFS 
fees? 
In order to ensure that you have funds to file EFS documents, you should establish an Electronic 
Funds Transfer (EFT) with a large Maximum EFT value. BC Online can set up an automated 
Electronic Funds Transfer (EFT) for your account to ensure that you always have the funds to 
cover EFS filings. 

The EFT requires three parameters to be set: 

• Account High Balance – The Account High Balance can be considered the “float”. Depending 
on the amount of work you do some high balances range from $50 to $500. 

• EFT Trigger Point – When the balance of your account falls below the Trigger Point, an EFT 
will be initiated during the overnight batch processing. 

• Maximum EFT Amount – The maximum amount that will be transferred. It is best to set this 
value high enough to cover the busiest day of any month in order to cover any negative 
balance that the account may experience. The EFT is done at the end of each business day. 

A typical set of EFT parameters for an account that normally does $500 worth of business a day 
could be as follows: 

• 1) Account High Balance: $50. 

• 2) EFT Trigger Point: $49. 

• 3) Maximum EFT: $2,000. 

Although the account in this example may do $500 of business a day, their Maximum EFT is set 
large enough to cover any unusual circumstances they may encounter. The EFT system will only 
transfer enough funds to bring the account balance up to $50. If the account did $500 of 
business, the EFT would only transfer $500. 

$50 Balance - $500 Work = $450 End of Day Balance + $500 EFT = $50 New Balance. 

The large Maximum EFT will cover additional filing the account does, or to cover EFS filings 
that may be delayed until future filing dates. 

For more information about EFT or Electronic Cheque, contact the BC Online Administration 
office at (250) 953-8250.  


